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関連資料: 資料の完全なリストについては、ここをクリックしてください。 

本アプリケーション ノートの最新版または関連するプロジェクト ファイルについては、

http://www.cypress.com/go/AN77759 をご覧ください。 

更にサンプル コードをお求めでしょうか？以下の通り対応いたします。 

PSoCサンプル コードのリストにアクセスするには、サンプル コードのウェブページをご覧ください。PSoCビデオ ライブラリについては

ここからご覧ください。 

本アプリケーション ノート (AN77759) では、Arm® Cortex®-M3ベースのプログラム可能なシステムオンチップである PSoC® 

5LP について紹介します。この文書で、PSoC 5LP のアーキテクチャおよび開発環境を説明し、PSoC 5LP の開発 

ツールである PSoC Creator™を使用して簡単なデザインを作成する方法を示します。また、本アプリケーション ノートは

PSoC 5LP と一般的な PSoCを深く理解できるようなリソースを提供します。 
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1 はじめに 

PSoC 5LP は、単一チップ上にカスタムのアナログとデジタルの周辺機能、メモリ、および Arm Cortex-M3 CPU を集積した、真
のプログラマブルな組み込みシステム オン チップです。 

PSoC 5LPは、MCU と外部 ICの組み合わせに代わるコスト効率の良いソリューションを提供しています。PSoC 5LPアーキテク
チャは下記によって性能を向上させます。 

▪ 80 MHzまでの 32ビット Arm Cortex-M3コア、DMAコントローラーおよびデジタル フィルター プロセッサ 

▪ 超低消費電力、業界最大の電圧範囲に対応 

▪ プログラマブルなデジタルおよびアナログ ペリフェラルでカスタム機能を実現可能   

▪ 任意のアナログまたはデジタル ペリフェラル機能から、任意のピンまでの柔軟性の高いルーティング 

単一の PSoCデバイスは 100 個までのデジタルおよびアナログ ペリフェラル機能を統合することができ、設計時間、基板面積、

消費電力およびシステム コストを低減しながらシステムの品質向上を実現します。 

 

 本書の使用法 

これより数ページで PSoC 5LP、および PSoCと PSoC Creatorで設計する利点について説明します。はじめての PSoC 5LP

デザインまでとばして、簡単なデザインを迅速にビルドすることもできます。そのセクションで作成するデザインはサンプル コード

CE203303にもあります。

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an77759-getting-started-psoc-5lp?source=search&keywords=AN77759
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=software_tools_meta_type%3A579&f%5b2%5d=field_related_products%3A88886
http://www.cypress.com/training
http://www.cypress.com/node/386956
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2 PSoC リソース 

サイプレスは、www.cypress.com に大量のデータを掲載しており、ユーザーがデザインに対して適切な PSoC デバイスを選択し、 
迅速に効率的にデバイスをデザインに統合するための手助けをしています。リソースの包括的なリストについては、 KBA86521, 
How to Design with PSoC 3, PSoC 4, and PSoC 5LPをご参照ください。以下は PSoC 5LPのリソースの要約です。 

▪ 概要: PSoCポートフォリオ、PSoCロードマップ 

▪ 製 品 セ レ ク タ ー : PSoC 1 、 PSoC 3 、 PSoC 4 、
PSoC 5LPまたはPSoC 6 MCU。それに加えて、PSoC 
Creatorにはデバイス選択ツールが含まれています。 

▪ データシート : PSoC 3、PSoC 4、PSoC 5LPおよび
PSoC 6 MCUデバイス ファミリ用の電気的仕様を説明
します。 

▪ CapSense® デザイン  ガイド : PSoC 3 、 PSoC 4 、
PSoC 5LPおよびPSoC 6 MCUファミリのデバイスを使用
して静電容量タッチ センシング アプリケーションを設計
する方法について説明します。 

▪ アプリケーション ノートおよびサンプル コード: 基本レベル
から高度なレベルまでの幅広いトピックを提供します。
多くのアプリケーション ノートはサンプル コードを含み
ます。 

▪ テクニカル リファレンス マニュアル (TRM): PSoC 3、
PSoC 4、PSoC 5LPおよびPSoC 6 MCUデバイス フ
ァミリのアーキテクチャとレジスタの詳細な説明を提供
します。 

▪ PsoCトレーニング動画: これらの動画はPSoCを用い
て、複雑なデザインをビルドする方法に関するステップ 
バイ ステップ指示を提供します。 

▪ 開発キット:  

□ CY8CKIT-030 はアナログ性能用に設計されていま
す。これにより、高精度アナログ、低消費電力かつ低
電圧のアプリケーションを開発し、評価することが可
能になります。 

□ CY8CKIT-001は、PSoC 1、PSoC 3、PSoC 4、ま
たは PSoC 5LP アーキテクチャのいずれかを使用
して開発した異なるソリューションを試作し評価する
共通開発プラットフォームを提供します。 

3 PSoC Creator 

PSoC Creatorは無料のWindowsベースの統合設計環境 (IDE) です。このキットにより、PSoC 3、PSoC 4、および PSoC 5LP
ベースのシステムについて、ハードウェアとファームウェアの同時並行の設計が可能です。図 1 に示すように、PSoC Creator に
より、以下のことが可能です。 

1. メイン デザイン ワークスペースでコンポーネント
をドラッグ & ドロップして、ハードウェア システム 
デザインを構築 

2. PSoCハードウェアとアプリケーション ファーム
ウエアを同時設計 

3. コンフィギゥレーション ツールを用いて、コンポー
ネントをコンフィギゥレーション 

4. 100以上のコンポーネントのライブラリを利用 

5. コンポーネント データシートをレビュー 

図 1. PSoC Creatorの主要点 

 

http://www.cypress.com/
http://www.cypress.com/
http://www.cypress.com/?id=4&rID=77024
http://www.cypress.com/?id=4&rID=77024
http://www.cypress.com/psoc
http://www.cypress.com/?rID=86788&source=an79953
http://www.cypress.com/?id=1573&source=an79953
http://www.cypress.com/?id=5041&source=an79953
http://www.cypress.com/?id=4976&source=an79953
http://www.cypress.com/?id=5044&source=an79953
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=107&id=4562&applicationID=0&l=0
http://www.cypress.com/search/all/capsense?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=resource_meta_type%3A574&f%5b2%5d=field_related_products%3A1292&f%5b3%5d=field_related_products%3A1307&f%5b4%5d=field_related_products%3A1297
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=76&id=4562&applicationID=0&l=0
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=117&id=4562&applicationID=0&l=0
http://www.cypress.com/?rID=72887
http://www.cypress.com/?rID=37833
http://www.cypress.com/video-library/PSoC
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=110&id=4562&applicationID=0&l=0
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-030-psoc-3-development-kit
http://www.cypress.com/?rID=51577&source=ce95314
http://www.cypress.com/psoccreator/?source=PSoC5LP_Datasheet
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3.1 PSoC Creatorヘルプ 

PSoC Creator ホーム ページへアクセスして PSoC Creator の最新版をダウンロードしてください。次に、PSoC Creator を起

動して、以下のアイテムへナビゲートします。 

▪ Quick Start Guide (クイック スタート ガイド): メニューから Help > Documentation > Quick Start Guideを選択します。

このガイドは PSoC Creatorプロジェクトを開発するための基礎知識を提供します。 

▪ Simple Component example projects (簡単なコンポーネント サンプル プロジェクト): メニューから File > Code 

Examplesを選択します。これらのサンプル プロジェクトは、PSoC Creatorのコンポーネントの設定と使用方法を示します。 

▪ System Reference Guide (システム  リファレンス  ガイド ): メニューから Help > System Reference > System 

Reference Guideを選択します。このガイドは、PSoC Creatorにより提供されるシステム機能を一覧にして、説明します。 

▪ Component datasheets (コンポーネント データシート): メニューから Componentを右クリックして「Open Datasheet」を

選択します。すべての PSoC 5LPのコンポーネント データシートの一覧については、 PSoC 5LP コンポーネント データシートの

ページへアクセスしてください。 

▪ Document Manager (ドキュメント マネージャー): PSoC Creatorは、ドキュメントリソースを容易に見つけレビューするのを助け

るために、Document Manager を提供します。Document Manager を開くには、メニューアイテムから Help >Document 

Managerを選択します。 

3.2 テクニカル サポート 

ご質問は、弊社のテクニカル サポート チームが対応いたします。 Cypress Technical Support ページにアクセスし、サポート 

リクエストを作成してください。 

米国のお客様は、弊社フリーダイヤル (+1-800-541-4736 ext.3) までお電話ください。テクニカルサポートチームと電話で話す

ことができます。 

早急な対応が求められる場合は、以下のサポート リソースをご利用ください。 

▪ セルフヘルプ 

▪ お近くの販売代理店 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.cypress.com/
http://www.cypress.com/?id=2494&source=an79953
http://www.cypress.com/?id=4749&rtID=377
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=377&id=4562
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=377&id=4562
https://secure.cypress.com/myaccount/?id=25&techSupport=1&source=an79953
http://www.cypress.com/support
http://www.cypress.com/?id=1062
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4 サンプル コード 

PSoC Creator は多数のサンプル コード プロジェクトを含んでいます。これらのサ

ンプル コードは、 図 2 に示すように、PSoC Creatorのスタート ページからアクセ

スできます。 

サンプル コードにより、新規からではなく完成した設計で始めるため、設計時間を短

縮させることができます。また、サンプル コードは、PSoC Creator コンポーネントを

様々なアプリケーションに使用する方法も示します。図 3 に示すように、サンプル コ

ードおよびデータシートが含まれています。 

図 3 に示す「Find Example Project」ダイアログには、いくつかのオプションがあり
ます。 

▪ アーキテクチャまたはデバイス  ファミリー  (PSoC 3、PSoC 4 または
PSoC 5LP)、カテゴリ、またはキーワードに基づいてサンプル プロジェクトを 

フイルターします。 

▪ 「Filter Options」にもとづいて提供されたサンプル プロジェクトから選択します。 

▪ 選択のためにデータシートをレビューします ( Documentation タブ上で)。 

▪ 選択のためにサンプル コードをレビューします。このウィンドウからコードをプロ 

ジェクトにコピー アンド ペーストして、コード開発時間を短縮することができます。 

▪ 選択に応じて新規プロジェクト (また、必要な場合は新規ワークスペース) を作
成します。これにより、完成した基本設計で開始するため、設計時間を短縮さ
せることができます。そのようにして設計をアプリケーションに適合させることが
可能です。 

図 2. PSoC Creatorのサンプル コード 

 

図 3. サンプル プロジェクトおよびサンプル コード 

 

http://www.cypress.com/
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5 PSoC 5LP機能セット 

PSoC 5LPは、図 4 (CY8C58xxLPデバイス ファミリの場合) に示すように 、CPUとメモリ サブシステム、デジタル サブシステム、

アナログ サブシステム、システム リソースを含む幅広い機能を備えています。 

詳細については、前の節でリストアップされた PSoC 5LPファミリ デバイス データシート、テクニカル リファレンス マニュアル(TRM)  

およびアプリケーション ノートをご参照ください。 

図 4. PSoC 5LPアーキテクチャ (CY8C58xxLP) 
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PSoC 5LPの主要な機能の一覧は以下の通りです。詳細については、関連資料または PSoC 5LPデバイス データシートをご参

照ください。 

▪ パフォーマンス 

 DC～80MHzで動作 

 32ビット Arm Cortex-M3 CPU、32個の割り込み 

 24チャネルのダイレクト メモリ アクセス (DMA) コントロー

ラー 

 24ビット、64タップのデジタル フィルター プロセッサ 

(DFB) 

▪ メモリ 

 最大 256KBのプログラム フラッシュ 

 エラー訂正コード (ECC) 用の最大 32KBの追加フラッシュ 

 最大 64KBの SRAM 

 2KBの EEPROM 

http://www.cypress.com/
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▪ デジタル周辺機能 

 4個の 16ビット タイマー、カウンター、PWM 

(TCPWM) 

 I2C、1Mbpsのバス速度 

 USB 2.0認定、フル スピード (FS) 12Mbps 

 フル CAN 2.0b、16個の Rx、8個の Txバッファ 

 20～24個のユニバーサル デジタル ブロック 

(UDB): 任意の数の機能を作成するようプログラム

可能 

▪ 8ビット、16ビット、24ビット、および 32ビットの

タイマー、カウンター、および PWM 

▪ I2C、UART、SPI、I2S、LIN 2.0インターフェース 

▪ 巡回冗長検査回路 (CRC) 

▪ 擬似乱数列 (PRS) ジェネレータ 

▪ 直交デコーダ 

▪ ゲート レベルのロジック機能 

▪ アナログ サブシステム 

 8～20ビットのコンフィグレーション可能なデルタ-

シグマ ADC 

 最大 2個の 12ビット SAR ADC 

 4個の 8ビット DAC 

 4個のコンパレーター 

 4個の演算増幅器 (オペアンプ) 

 下記を作成するための 4個のプログラマブルなア

ナログ ブロック 

▪ プログラマブル ゲイン アンプ (PGA) 

▪ トランスインピーダンス アンプ (TIA) 

▪ ミキサー 

▪ サンプル／ホールド (S/H) 回路 

 CapSense®サポート、最大 62個のセンサー 

 1.024V±0.1%の内部電圧リファレンス 

 
 
 
 
 
 
 
 
 
 
 
 
 

▪ 汎用性の高い I/Oシステム 

 46～72個の I/Oピン – 最大 62個までの汎用 I/O 

(GPIO) 

 最大 8個までのパフォーマンス I/O (SIO) ピン 

▪ 25mAの電流シンク 

▪ プログラム可能な入力閾値および出力 HIGH電

圧 

▪ 汎用アナログ コンパレーターとして動作可能 

▪ ホット スワップ機能および過電圧許容 

 GPIOとして使用可能な 2個の USBIOピン 

 任意のデジタルまたはアナログ ペリフェラルから任

意の GPIOへの接続 

 任意の GPIOから LCD直接駆動、最大 46×16セ

グメント 

 任意の GPIOから CapSenseをサポート 

 1.2V～5.5Vのインターフェース電圧、最大 4個の

パワー ドメイン 

▪ プログラム可能なクロッキング 

 3MHz～74MHzの内部発振器、3MHzで精度が 1% 

 4MHz～25MHzの外部水晶発振器 

 内部 PLLクロック生成、最大 80MHz 

 低消費電力内部発振器、1KHz、33KHz、100KHz 

 32.768kHzの外部時計用水晶発振器 

 12個のクロック分周器-任意のペリフェラルまたは

I/Oにルーティング可能 

PSoC 5LP 機能の全面的なレビューについては、データシー

トをご参照ください。 

http://www.cypress.com/
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5.1 PsoCの MCUより優れている点 

図 5に示すように、標準的な MCUは、CPU、および ADC、DAC、UART、SPI等の周辺機能、および汎用 I/Oを含んでいます。

これらはすべて CPU のレジスタ インターフェースにリンクします。MCU の中では、CPU がデバイス の「心臓」です。CPU は 

セットアップ、データ移動、タイミングのすべてを管理します。CPUがないと、MCUは動作不可能です。 

図 6に示すように、PSoCは全く違います。CPU、アナログ、デジタルおよび I/Oは、プログラマブルなシステムで同等に重要な

リソースです。 PSoCの心臓は CPUではなく、システムの相互接続とプログラマビリティです。アナログとデジタル ペリフェラル

は高度にコンフィギュレーション可能な配線マトリックスと相互接続されます。これにより、ユーザーはアプリケーションの要件を

正確に満たすカスタム設計を作成することができます。PSoC をプログラムして MCU をエミュレートできますが、MCUをプログラム

して PSoCをエミュレートすることはできません。 

図 5. 標準 MCUのブロック図 
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図 6. PSoC 5LPのブロック図 
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標準的な MCUは、ステート マシンを処理し、タイマーをタイミングに使用し、出力ピンを駆動するために、CPUファームウェアを

必要とします。従って、機能的パスはたいていいつも CPU を介します。しかし、PSoC を用いると非同期の平行処理が可能です。

PSoCのコンポーネントが CPUから独立して動作するように設定可能です。 

例えば、図 6 は、UARTがない PSoC 5LP を示します。しかし、ユーザーは、PSoC Creator の予め設計および予めテストした

UARTコンポーネントを使って、コンフィギュレーション可能なデジタル ロジックの範囲内で必要とする UART数だけ作成すること

ができます。また、それぞれの UARTが必要とするだけの機能を持つように設定できます。 

5.2 PSoC Creator コンポーネントの概念 

PSoCデザインが成功するための鍵となるのは PSoC Creator IDEです。PSoC Creatorは、「コンポーネント」と呼ばれている

グラフィック要素としての PSoCペリフェラルと他のリソースを含んでいます。コンポーネントは回路図にドラッグ & ドロップされ、

互いに接続されるため、設計を迅速で簡単にできます。設計の変更は数回のマウス クリックだけで即座に実現できます。 

例えば、従来の MCUでは、PWMペリフェラルを使用して LEDを点滅させるには、次の操作を行わなければなりません。 

1.  PWMに対応するレジスタの位置を確定。 

2.  要求される PWM周期およびデューティ比に基づいて、PWMレジスタに書き込まれる値を計算。 

3.  PWMレジスタを設定して、ピン ドライブ モードを設定し、PWM出力をピンに接続するための数多くのコード行を書く。 

PSoCで同様な機能を実装するには、本アプリケーション ノートの次の節で説明するように、簡単な操作です。 

CPU 

Arm Cortex-M3 
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ピン コンポーネント: 任意の機能を任意のピンに接続 

PSoC 5LP は広大な配線構造を含み、ほとんどの機能 (デジタルまたはアナログ) を任意のピンに接続することができます。

PSoC Creator が提供するピン コンポーネントを利用すると、数回のマウス クリックだけで設定を完成させ、PSoC リソースに 

接続し、物理ピンに接続できるため、機能とピンの接続は簡単になります。また、ピン コンポーネントの接続を簡単に変更できる

ため、基板レベルの設計の変更を迅速に処理できます。 

プログラマブルなデジタル リソースに基づくコンポーネント 

PSoC 5LP には、ユニバーサル デジタル ブロック (UDB) と呼ばれるプログラム可能なデジタル ブロックがあります。PSoC 

Creatorは UDBから作られた多くのコンポーネントを提供します。UART、SPI、I2C 、I2S、タイマー、PWM、カウンター、CRC、

直交デコーダ、デジタル ゲート (AND、OR、NOT、XORなど) を始め、他にも多くのものが含まれています。さらに、自分のカスタム 

ステート マシンおよびデジタル ロジックを作り上げることが可能です。 

プログラマブルなアナログ リソースに基づくコンポーネント 

PSoC 5LP には、スイッチト キャパシタ連続時間 (SC/CT) ブロックと呼ばれるプログラム可能なアナログ ブロックもあります。

PSoC Creatorは、プログラマブル ゲイン アンプ (PGA) やトランスインピーダンス アンプ (TIA) のような SC/CTブロックから 

作られたアナログ コンポーネントを提供します。 

 

6 はじめての PSoC 5LPデザイン 

この節の内容は以下の通りです。 

▪ 従来の MCUができる以上のことを行うために、どのように PSoCがプログラムされ得るかを示します。 

▪ 単純な PSoC設計のビルド方法、その設計を開発キットにインストールする方法を示します。 

▪ PSoC Creator IDEを使って、PSoC設計技術の学習を容易にする詳細な手順を提供します。 

6.1 始める前に準備するもの 

PSoC Creatorをインストールしましたか？ 

PSoC Creator ホーム ページから PSoC Creator をダウンロードし、インストールします。インストールに時間がかかることが 

あります。詳細については、PSoC Creator リリース ノートをご参照ください。 

開発キットを持っていますか？ 

表 1に PSoC  5L P用のすべてのサイプレス開発キットを示します。他のメーカーのキットも利用できます。 

表 1. サイプレスの PSoC 5LPキット 

PSoC 5LPキット PSoC 5LPデバイスの製品番号 プログラミング 

CY8CKIT-059 CY8C5888LTI-LP097 プログラマを内蔵 

CY8CKIT-050 CY8C5868AXI-LP035 プログラマを内蔵 

CY8CKIT-001 CY8C5868AXI-LP035 MiniProg3プログラムおよびデバッグキット 

実行中のプロジェクトをご覧になりたいですか？ 

次のセクションで説明する開発過程が必要ない場合、CE203303 から完成したサンプル プロジェクトをご利用できます。そして、 

 ビルドおよびプログラムのステップへ進むことができます。サンプル コードは CY8CKIT-059向けに設計されますが、他のキット

のために簡単に修正できます。 

http://www.cypress.com/
http://www.cypress.com/go/creator
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-059-psoc-5lp-prototyping-kit
http://www.cypress.com/?rID=51577&source=ce95314
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-001-psoc-development-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-002-psoc-miniprog3-program-and-debug-kit
http://www.cypress.com/node/386956
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-059-psoc-5lp-prototyping-kit
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6.2 デザインについて 

このデザインは「CE203303-PSoC 3 and PSoC 5LP Breathing LED」のサンプル コードで詳しく説明されます。初期化後に

CPUを使わずに「ブリージング LED」効果をハードウェアだけで実装します。図 7に PSoC Creatorの回路図を示します。 

図 7. ブリージング LEDの回路図 (ピンおよび LEDを CY8CKIT-059用に選択) 

 

6.3 パート 1: デザインの作成 

この節は設計の過程について順序を追って説明します。ハードウェアとファームウェア両方の設計エントリについて説明します。 

注： これらの手順では、ユーザーが PSoC Creator 3.3を利用していることを前提にします。全体的な開発過程は、PSoC Creatorの

他のバージョンでも同様ですが、ダイアログ ボックスの一部が異なることがあります。 

1. 新しい PSoC Creatorプロジェクトを作成します。 

プロジェクトには、すべてのソース コード、およびターゲットである PSoC 5LPデバイスにダウンロードできる 1つの出力モジュー

ルを作成するのに必要なファイルが含まれています。 

A. PSoC Creatorを起動します。                                                    

B. 図 8に示すように、メニューから 

File > New > Project… を選択します。  

「Create Project」ウィンドウが表示されます。 

 

 

図 8. 新しい PSoC Creatorプロジェクトの作成 

  

http://www.cypress.com/


 
 
 

PSoC 5LP入門 
 

www.cypress.com 文書番号: 001-97882 Rev. *C 10 

2. CY8CKIT-059キットのプロジェクトの種類を選択します。 (図 9を参照) 

PSoC Creatorは、様々なプロジェクト オプションを特定の開発キットやターゲット デバイス用に自動的に設定することで、 

開発時間を短縮させることができます。 

A. 「Target hardware」をクリックします。 

B. プルダウン メニューから「Kit: CY8CKIT-059 (PSoC 5LP)」を選択します。 

C. 「Next」をクリックします。 

図 9. CY8CKIT-059の新しいプロジェクトを作成 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

A 

B 

C 

http://www.cypress.com/
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-059-psoc-5lp-prototyping-kit
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3. 空の回路図をプロジェクト テンプレートとして選択します。 (図 10を参照) 

PSoC Creatorは、既存のサンプル コードに基づいて新しいデザインを作ることで開発時間を短縮させることができます。 

この場合では、空の回路図から開始します。 

A. 「Empty Schematic」をクリックします。 

B. 「Next」をクリックします。 

C. 次のダイアログの「Workspace name」にワークスペースの名前を入力します。1 つのワークスペースはいくつかの 

プロジェクトを格納できます。プロジェクトは通常、ワークスペースに格納されます。 

D. 「Project name」にプロジェクトの名前を入力します。プロジェクト名とワークスペース名は同じでも違っても構いません。 

E. ワークスペースとプロジェクトの「Location」を指定します。 

F. 「Finish」をクリックします。 

図 10. 新しい空のプロジェクトの作成 

 

 

プロジェクトが作成されました。いくつかの新しいペインが表示されます: Workspace Explorer、Schematic 

(TopDesign.cysch)、および Component Catalog。 
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F 
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4.  デザインのハードウェア部分をビルドします。

このステップでは、コンポーネントを「Component 

Catalog」から回路図にドラッグします。その後、 

それぞれのコンポーネントを設定し、互いに接続し

ます。 

a. 図 11 に示すように、「Component Catalog」

ウィンドウの Cypress タブで、PWM コンポー

ネントを検索します。 

b. PWM コンポーネントの 2 つのインスタンスを

回路図にドラッグします (図 7を参照)。 

図 11. PWMコンポーネントの選択 

 

 

http://www.cypress.com/
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5. PWMコンポーネントを設定します。 (図 12を参照) 

両方の PWMから方形波の出力が生成されますが、方形波の周波数は少し異なります。周波数の差により、LEDで変調さ

れるビート周波数が発生します。 

回路図で、それぞれの PWMコンポーネントをダブルクリックして設定します。 

A. PWM_1の PWM Modeを One Outputに変更します。 

B. PWM_1に対する更なる変更は不要です。OKをクリックしてダイアログを閉じます。 

C. PWM_2の PWM Modeを One Outputに変更します。 

D. PWM_2の Period値をデフォルト値から少し外れた値に設定します。 

E. PWM_2の CMP Value 1を Period値の約半分に設定します。 

F. PWM_2の変更が完了しました。OKをクリックして、ダイアログ ボックスを閉じます。 

図 12. PWMコンポーネントの設定 

   

6. 表 2に示す追加のコンポーネントを Component Catalogから回路図にドラッグして設定します。  

Off-Chipのコンポーネントは必須ではありませんが、デザインの全体的な目的を示すのに役立ちます。 

各コンフィギュレーション ダイアログでは Name フィールドは自動的に挿入される点にご注意ください。他の有効な名前

に変更可能です。回路図で各コンポーネント名は唯一なものでなければなりません。 

表 2. デザイン コンポーネント 

コンポーネント 

コンポーネント カタログ 

デフォルト設定からの変更 タブ グループ 

Logic Low Cypress デジタル > ロジック なし 

Xor Cypress デジタル > ロジック なし 

Clock Cypress システム 「Frequency」を 5kHzにセット 

Digital Output Pin Cypress ポートとピン 「External terminal」ボックスにチェックを入れる 

Resistor Off-Chip 受動コンポーネント なし 

LED Off-Chip ダイオード なし 

Ground Off-Chip パワー なし 

A C 

D 

E 
B 

F 
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7. ワイヤー ツールを選択して(図 13を参照) ロジックを接族

続します (またはショートカットとして「w」を押します) 

図 7に示すように、コンポーネントを接続します。 

 

            図 13. ワイヤー ツールの選択 

 

8. これで、ハードウェアの設計が完成しましたが、ピン コンポーネントを物理ピンに接続しなければなりません。 

使用中の開発キット上の LED用の物理ピンを選択します。 (CY8CKIT-059の場合、ポート 2のピン 1 (P2[1]) が使用さ

れます) 

A. 図 14 に示すように、Workspace Explorer ウィンドウで、プロジェクト内の.cydwr ファイルをダブルクリックします。 

そうすると、「Design wide resource (DWR)」ウィンドウが開きます。 

B. 「Pins」タブを選択します。プロジェクトで定義されたピン コンポーネント、およびターゲット デバイスのピンの配置図

が表示されます。 

C. 回路図のピン コンポーネントを所望の物理ピンに接続します。 

図 14. ピンの割り当て 

 

 
9. ここで、数行のファームウェアを書く必要があります。その前に、PSoC Creator が、コンポーネントに関連するすべての 

コードを生成するようにします。 

図 15に示すように、PSoC Creator メニューから、Build > 

Generate Application を選択します。 エラーがなけれ

ば、PSoC Creatorは Generated_Sourceフォルダにいく

つかのコード ファイルを生成します。 

 

図 15. アプリケーションの生成 
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10. コードを自動的に生成したファイル main.c に追加します。コードを追加するためのフレームワークがあります。2 個の
PWM コンポーネントを起動するために追加しなければならないコードは、コード 1 に示すように、ハイライト表示されます。
Workspace Explorerウィンドウで、プロジェクトの main.cファイルをダブルクリックして開きます。 

注: このコードでは、PWM コンポーネントはデフォルトの名前であることを前提にします。PWM コンポーネントをデフォルト 

以外の名前に変更する場合、「_Start()」 関数呼び出しでその名前を使用します。 

コード 1. ブリージング LEDのメイン コード 

#include <project.h> 

 

int main() 

{ 

    //CyGlobalIntEnable; /* Enable global interrupts. */ 

 

    /* Place your initialization/startup code here (e.g. MyInst_Start()) */ 

    PWM_1_Start(); 

    PWM_2_Start(); 

 

    for(;;) 

    { 

        /* Place your application code here. */ 

    } 

} 

 

11. 設計過程を飛ばしてこのステップに進んだ場合、以下のようにしてください: 

A. CE203303.zipのサンプル コードのファイルを CE203303からダウンロードし、コンピューターの使いやすい所に解
凍します。 

B. 9ページの「ステップ 1」に説明したように、PSoC Creatorをダウンロードし、インストールします。 

C. PSoC Creatorで CE203303.cywrkファイルを開きます。 

D. 15ページの「ステップ 8」に説明したように、プロジェクトのピン割り当てが開発キット (DVK) に一致することを確認します。  

E. 図 16示すように、PSoC Creatorのメニューから
Build > Build <プロジェクト名>を選択します。
エラーがなければ、プロジェクトはビルドされ、
ターゲットの DVK にプログラムできる状態に
なります。 

                        図 16. プロジェクトのビルド 

 

http://www.cypress.com/
http://www.cypress.com/node/386956
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6.4 パート 2: デバイスのプログラム 

プログラム過程はすべての開発キット基板で同様です。DVKを設定するために、キット ガイド ドキュメントの説明書に従ってく

ださい。 

1. PSoC Creatorとユーザーの DVKの接続を確認します。 

図 17に示すように、PSoC Creatorのメニュー

から Debug > Select Debug Targetを選択し

ます。 

A. 図 18 に示すように、「 Select Debug 

Target」ダイアログが表示されます。ター

ゲットの DVK をクリックします  (PSoC 

Creator は多くの DVK 接続をサポートし

ます) 。 

B. Port Acquireをクリックします。 

図 17. デバッグ ターゲットの選択 

 

図 18. プログラム用のターゲットの選択と取得 

 
 
 
 
 
 

A 

B 
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2.   ターゲットの DVK上の PSoCに接続します。図 19をご参照ください。 

A. PSoC 5LPをクリックします。 

B. Connect をクリックします。「Target unacquired」メッセージは「Target acquired」に変わり、ボタンのラベルは
「Disconnect」に変更されます。 

C. OKをクリックしてダイアログを閉じます。 

これで、PSoC Creatorはターゲットの DVKと PSoCに接続し、PSoCをプログラムすることが可能になります。 

図 19.  ターゲットの PSoC 5LPへの接続 

 

3. 図 20 に示すように、PSoC 5LP をプログラムする
ために、PSoC Creator のメニューから Debug > 

Programを選択します。 

4. プログラミングが開始します。図 21 に示すように、
プログラミングのステータスは PSoC Creator の 

ステータス バー (画面の左下隅) に表示されます。 

注: 「This programmer is currently out of date  

(このプログラマは現在、古いものになりました)」の
警告メッセージが表示される場合があります。 

プログラマ ファームウェアをアップグレードする方法
については、キットの資料にある KitProgユーザー ガ
イドをご参照ください。 

 図 20. デバイスのプログラム 

 

図 21. プログラミングのステータス 

 

CY8CKIT-059 DVKでは、青色の LEDが数秒で徐々に完全 ONから完全 OFFの状態に変わります。 

A 

B 

C 
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http://www.cypress.com/documentation/development-kitsboards/cy8ckit-059-psoc-5lp-prototyping-kit


 
 
 

PSoC 5LP入門 
 

www.cypress.com 文書番号: 001-97882 Rev. *C 18 

7 まとめ 

本アプリケーション ノートは PSoC 5LPアーキテクチャおよび開発ツールを説明した。本アプリケーション ノートから得られる最も

重要なコンセプトは PSoCがMCUより優れていることです 。PSoC 5LPは、真のプログラマブルな組み込みシステム オン チップです。

そこでは単一チップ上にコンフィグレーション可能なアナログとデジタル ペリフェラル機能、メモリ、および 32 ビット Cortex-M3 

CPUが集積されています。 

集積した機能と低リーク電力モードにより、PSoC 5LPは低消費電力とコスト効率の高い組み込みシステムとして理想的な選択です。 

8 関連資料 

表 3に、PSoCと PSoC Creatorの次段階の理解に推奨するシステム レベルの一般的なアプリケーション ノートを示します。 

表 3. 一般的なシステム レベルのアプリケーション ノート 

文書番号 文書名 

AN61290、 

AN88619 

PSoC® 3 and PSoC 5LP Hardware Design Considerations, 
PSoC® 4 Hardware Design Considerations 

AN81623 PSoC® 3, PSoC 4, and PSoC 5LP Digital Design Best Practices 

AN77900、 

AN86233、 

AN90114 

PSoC® 3 and PSoC 5LP Low-power Modes and Power Reduction Techniques, 
PSoC® 4 Low-power Modes and Power Reduction Techniques, 
PSoC® 4000 Low-power Modes and Power Reduction Techniques 

AN68403 PSoC® 3 and PSoC 5LP Analog Signal Chain Calibration 

AN57821 PSoC® 3, PSoC 4, and PSoC 5LP Mixed-Signal Circuit Board Layout Considerations 

AN58827 PSoC® 3 and PSoC 5LP Internal Analog Routing Considerations 

AN73854 PSoC® 3, PSoC 4, and PSoC 5LP Introduction to Bootloaders 

AN60616 PSoC® 3 and PSoC 5LP Startup Procedure 

AN60631 PSoC® 3 and PSoC 5LP Clocking Resources 

AN77835 PSoC® 3 to PSoC 5LP Migration Guide 

AN78175、 

AN89056 

PSoC® 3 and PSoC 5LP IEC60730 Class B Safety Software Library, 
PSoC® 4 IEC60730 Class B Safety Software Library 

 

表 4のデバイス説明に関連するアプリケーション ノート (AN)、サンプル コード (CE)、および知識ベース記事 (KBA) を示します。 

表 4. PSoC 5LP機能に関連する資料 

文書番号 文書名 

CPUおよび割り込み 

AN89610 PSoC® 4 and PSoC 5LP Arm Cortex Code Optimization 

AN54460 PSoC® 3 and PSoC 5LP Interrupts 

メモリ 

CE95313 PSoC® 3, PSoC 4, and PSoC 5LP Emulated EEPROM Memory 

ダイレクト メモリ アクセス (DMA) 

AN52705 PSoC® 3 and PSoC 5LP – Getting Started with DMA 

AN84810 PSoC® 3 and PSoC 5LP Advanced DMA Topics 

AN61102 PSoC® 3 and PSoC 5LP – ADC Data Buffering Using DMA 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an61290-psoc-3-and-psoc-5lp-hardware-design-considerations
http://www.cypress.com/documentation/application-notes/an88619-psoc-41004200-hardware-design-considerations
http://www.cypress.com/documentation/application-notes/an81623-psoc-3-psoc-4-and-psoc-5lp-digital-design-best-practices
http://www.cypress.com/documentation/application-notes/an77900-psoc-3-and-psoc-5lp-low-power-modes-and-power-reduction
http://www.cypress.com/documentation/application-notes/an86233-psoc-4-low-power-modes-and-power-reduction-techniques
http://www.cypress.com/documentation/application-notes/an90114-psoc-4000-family-low-power-system-design-techniques
http://www.cypress.com/documentation/application-notes/an68403-psoc-3-and-psoc-5lp-analog-signal-chain-calibration
http://www.cypress.com/documentation/application-notes/an57821-psoc-3-psoc-4-and-psoc-5lp-mixed-signal-circuit-board-layout
http://www.cypress.com/documentation/application-notes/an58827-psoc-3-and-psoc-5lp-internal-analog-routing-considerations?source=search&keywords=AN58827
http://www.cypress.com/documentation/application-notes/an73854-psoc-3-psoc-4-and-psoc-5lp-introduction-bootloaders
http://www.cypress.com/documentation/application-notes/an60616-psoc-3-and-psoc-5lp-startup-procedure
http://www.cypress.com/documentation/application-notes/an60631-psoc-3-and-psoc-5lp-clocking-resources
http://www.cypress.com/documentation/application-notes/an77835-psoc-3-psoc-5lp-migration-guide
http://www.cypress.com/documentation/application-notes/an78175-psoc-3-and-psoc-5lp-iec-60730-class-b-safety-software
http://www.cypress.com/documentation/application-notes/an89056-psoc-4-iec-60730-class-b-and-iec-61508-sil-safety-software
http://www.cypress.com/documentation/application-notes/an89610-psoc-4-and-psoc-5lp-arm-cortex-code-optimization
http://www.cypress.com/documentation/application-notes/an54460-psoc-3-and-psoc-5lp-interrupts
http://www.cypress.com/documentation/code-examples/ce95313-emulated-eeprom-memory-psoc-345lp
http://www.cypress.com/documentation/application-notes/an52705-psoc-3-and-psoc-5lp-getting-started-dma
http://www.cypress.com/documentation/application-notes/an84810-psoc-3-and-psoc-5lp-advanced-dma-topics
http://www.cypress.com/documentation/application-notes/an61102-psoc-3-and-psoc-5lp-adc-data-buffering-using-dma
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文書番号 文書名 

CE95375 
CE95376 

SPI Master and DMA with PSoC® 3 and PSoC 5LP 
SPI Slave and DMA with PSoC® 3 and PSoC 5LP 

デジタル フィルタ ブロック (DFB) 

CE95316 Filter From ADC to VDAC Using DFB with PSoC® 3 and PSoC 5LP 

CE95317 Filter From ADC to VDAC Using DFB in Polling Mode with PSoC® 3 and PSoC 5LP 

I2C 

CE95324 I2C LCD with PSoC® 3 and PSoC 5LP 

CE95314 PSoC® 3, PSoC 4, and PSoC 5LP EZI2C 

USB 

AN57294 USB 101: An Introduction to Universal Serial Bus 2.0 

AN57473 USB HID Basics with PSoC® 3 and PSoC 5LP 

AN58726 USB HID Intermediate with PSoC® 3 and PSoC 5LP 

AN56377 PSoC® 3 and PSoC 5LP – Introduction to Implementing USB Data Transfers 

AN82072 PSoC® 3 and PSoC 5LP USB General Data Transfer with Standard HID Drivers 

AN73503 USB HID Bootloader for PSoC® 3 and PSoC 5LP 

CE95390 USB Audio with PSoC® 3 and PSoC 5LP 

CE95395 USB MIDI with PSoC® 3 and PSoC 5LP 

CE95394 USB HID Mouse with PSoC® 3 and PSoC 5LP 

CE95393 USB Bulk Transfer with PSoC® 3 and PSoC 5LP 

CE95392 USB Bootloader with PSoC® 3 and PSoC 5LP 

CE95396 USB UART with PSoC® 3 and PSoC 5LP 

コントローラー エリア ネットワーク (CAN) 

AN52701 PSoC® 3 and PSoC 5LP – Getting Started with Controller Area Network (CAN) 

CE95282 CAN as Control Node with PSoC® 3 and PSoC 5LP 

CE95283 CAN as Remove Node with PSoC® 3 and PSoC 5LP 

KBA86565 Difference Between Full CAN and Basic CAN Mailbox 

KBA86566 Acceptance Filter Implementation for CAN Receive Message 

KBA86567 Modifying the Full CAN Mailbox’s Identifier in the Program 

ユニバーサル デジタル ブロック (UDB) 

AN82250 PSoC® 3, PSoC 4, and PSoC 5LP – Implementing Programmable Logic Designs with Verilog 

AN82156 PSoC® 3, PSoC 4, and PSoC 5LP – Designing PSoC CreatorTM Components with UDB Datapaths 

CE95295 8-Bit UDB Counter with PSoC® 3 and PSoC 5LP 

CE95384 16-Bit UDB-Based Timer with PSoC® 3 and PSoC 5LP 

CE95323  Hardware Fan Control with PSoC® 3 and PSoC 5LP 

KBA85325 Comparison of Resource Utilization Between PSoC® 3 and PSoC 5LP UDBs and Other Vendor CPLDs 

KBA86336 Just Enough Verilog for PSoC® 

http://www.cypress.com/
http://www.cypress.com/documentation/code-examples/ce95375-spi-master-and-dma-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95376-spi-slave-and-dma-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95316-filter-adc-vdac-using-dfb-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95317-filter-adc-vdac-using-dfb-polling-mode-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95324-i2c-lcd-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95314-psoc-3-psoc-4-and-psoc-5lp-ezi2c
http://www.cypress.com/documentation/application-notes/an57294-usb-101-introduction-universal-serial-bus-20?source=search&keywords=AN57294
http://www.cypress.com/documentation/application-notes/an57473-usb-hid-basics-psoc-3-and-psoc-5lp?source=search&keywords=AN57473
http://www.cypress.com/documentation/application-notes/an58726-usb-hid-intermediate-psoc-3-and-psoc-5lp?source=search&keywords=AN58726
http://www.cypress.com/documentation/application-notes/an56377-psoc-3-and-psoc-5lp-introduction-implementing-usb-data?source=search&keywords=AN56377
http://www.cypress.com/documentation/application-notes/an82072-psoc-3-and-psoc-5lp-usb-general-data-transfer-standard-hid?source=search&keywords=AN82072
http://www.cypress.com/documentation/application-notes/an73503-usb-hid-bootloader-psoc-3-and-psoc-5lp?source=search&keywords=AN73503
http://www.cypress.com/documentation/code-examples/ce95390-usb-audio-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95395-usb-midi-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95394-usb-hid-mouse-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95393-usb-bulk-transfer-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95392-usb-bootloader-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95396-usb-uart-psoc-35lp
http://www.cypress.com/documentation/application-notes/an52701-psoc-3-and-psoc-5lp-getting-started-controller-area-network
http://www.cypress.com/documentation/code-examples/ce95282-can-control-node-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95283-can-remove-node-psoc-35lp
http://www.cypress.com/knowledge-base-article/difference-between-full-can-and-basic-can-mailbox-kba86565
http://www.cypress.com/knowledge-base-article/acceptance-filter-implementation-can-receive-message-kba86566?source=search&keywords=KBA86566
http://www.cypress.com/knowledge-base-article/modifying-full-can-mailbox-s-identifier-program-kba86567?source=search&keywords=KBA86567
http://www.cypress.com/documentation/application-notes/an82250-psoc-3-psoc-4-and-psoc-5lp-implementing-programmable-logic?source=search&keywords=AN82250
http://www.cypress.com/documentation/application-notes/an82156-psoc-3-psoc-4-and-psoc-5lp-designing-psoc-creator-components?source=search&keywords=AN82156
http://www.cypress.com/documentation/code-examples/ce95295-8-bit-udb-counter-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95384-16-bit-udb-based-timer-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95323-hardware-fan-control-psoc-35lp
http://www.cypress.com/knowledge-base-article/comparison-resource-utilization-between-psoc-3-psoc-5-and-psoc-5lp-udbs-and
http://www.cypress.com/knowledge-base-article/just-enough-verilog-psoc-kba86336?source=search&keywords=KBA86336
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文書番号 文書名 

アナログ-デジタル変換器 (ADC) 

AN84783 Accurate Measurement Using PSoC® 3 and PSoC 5LP Delta-Sigma ADC 

CE95277 Delta-Sigma ADC in Single-Ended Mode with PSoC® 3 and PSoC 5LP 

CE95271 Delta-Sigma ADC in Differential Mode with PSoC® 3 and PSoC 5LP 

CE95276 Sequencing SAR ADC with PSoC® 3 and PSoC 5LP 

KBA81866 Best Method of Amplification to Get Better Performance from PSoC® 3 and PSoC 5LP Delta-Sigma ADC 

KBA84753 Choice of Reference Voltage for Accurate ADC Measurements in PSoC® 3, PSoC 4 and PSoC 5LP 

デジタル-アナログ変換機 (DAC) 

AN60305 Using PSoC® 3 and PSoC 5LP IDACs to build a better VDAC 

AN64275 PSoC® 3 and PSoC 5LP: Getting More Resolution from 8-Bit DACs 

AN69133 PSoC® 3 and PSoC 5LP Easy Waveform Generation with the WaveDAC8 Component 

CE95397 Voltage DAC with PSoC® 3 and PSoC 5LP 

CE95309 Dithered Voltage DAC with PSoC® 3 and PSoC 5LP 

KBA84732 VDAC8 Output Voltage in PSoC® 3 and PSoC 5 

KBA83238 Driving an External Load using VDAC in PSoC® 3 or PSoC 5 

コンパレータ 

AN60220 PSoC® 3 and PSoC 5LP Multiplexed Comparator 

CE95292 Analog Voltage Comparator with PSoC® 3 and PSoC 5LP 

CE95361 Scanning Comparator Using Internal VDAC with PSoC® 3 and PSoC 5LP 

CE95360 Scanning Comparator Using Common Mode with PSoC® 3, PSoC 4, and PSoC 5LP 

演算増幅器 (オペアンプ) 

CE95339 Operational Amplifier (Opamp) with PSoC® 3 and PSoC 5LP 

プログラマブル アナログ ブロック (SC/CT) 

AN60321 Peak Detection with PSoC® 3 and PSoC 5LP 

AN62582 AM Modulation and Demodulation 

CE95342 Programmable Gain Amplifier (PGA) with PSoC® 3 and PSoC 5LP 

CE95343 Inverting Programmable Gain Amplifier with PSoC® 3 and PSoC 5LP 

CE95383 Transimpedance Amplifier (TIA) with PSoC® 3 and PSoC 5LP 

CE95357 Sample and Hold with PSoC® 3 and PSoC 5LP 

CE95337 Analog Signal Mixer with PSoC® 3 and PSoC 5LP 

CapSense 

AN75400 PSoC® 3 and PSoC 5LP CapSense® Design Guide 

CE95287 CapSense® CSD Using Tuner with PSoC® 3 and PSoC 5LP 

CE95284 CapSense® CSD Design with PSoC® 3 and PSoC 5LP 

I/O 

AN72382 Using PSoC® 3 and PSoC 5LP GPIO Pins 

AN60580 SIO Tips and Tricks in PSoC® 3 and PSoC 5LP 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an84783-accurate-measurement-using-psoc-3-and-psoc-5lp-delta-sigma?source=search&keywords=AN84783
http://www.cypress.com/documentation/code-examples/ce95277-delta-sigma-adc-single-ended-mode-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95271-delta-sigma-adc-differential-mode-psoc-35lp?source=search&keywords=ADC&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95276-sequencing-sar-adc-psoc-5lp
http://www.cypress.com/knowledge-base-article/best-method-amplification-get-better-performance-psoc-3-or-psoc-5-del-sig-adc?source=search&keywords=KBA81866
http://www.cypress.com/knowledge-base-article/choice-reference-voltage-accurate-adc-measurements-psoc-3-psoc-4-and-psoc-5lp?source=search&keywords=KBA84753
http://www.cypress.com/documentation/application-notes/an60305-using-psoc-3-and-psoc-5lp-idacs-build-better-vdac
http://www.cypress.com/documentation/application-notes/an64275-psoc-3-and-psoc-5lp-getting-more-resolution-8-bit-dacs
http://www.cypress.com/documentation/application-notes/an69133-psoc-3-psoc-5lp-easy-waveform-generation-wavedac8-component
http://www.cypress.com/documentation/code-examples/ce95397-voltage-dac-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95309-dithered-voltage-dac-psoc-35lp
http://www.cypress.com/knowledge-base-article/vdac8-output-voltage-psoc-3-and-psoc-5-kba84732
http://www.cypress.com/knowledge-base-article/driving-external-load-using-vdac-psoc-3-or-psoc-5-kba83238
http://www.cypress.com/documentation/application-notes/an60220-psoc-3-psoc-5lp-multiplexed-comparator
http://www.cypress.com/documentation/code-examples/ce95292-analog-voltage-comparator-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95361-scanning-comparator-using-internal-vdac-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95360-scanning-comparator-using-common-mode-psoc-345lp
http://www.cypress.com/documentation/code-examples/ce95339-operational-amplifier-opamp-psoc-35lp?source=search&keywords=CE95339
http://www.cypress.com/documentation/application-notes/an60321-peak-detection-psoc-3-and-psoc-5lp
http://www.cypress.com/documentation/application-notes/an62582-am-modulation-and-demodulation
http://www.cypress.com/documentation/code-examples/ce95342-programmable-gain-amplifier-pga-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95343-inverting-programmable-gain-amplifier-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95383-transimpedance-amplifier-tia-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95357-sample-and-hold-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95337-analog-signal-mixer-psoc-35lp
http://www.cypress.com/documentation/application-notes/psoc-3-and-psoc-5lp-capsense-design-guide?source=search&keywords=PSoC%C2%AE%203&cat=technical_documents
http://www.cypress.com/documentation/code-examples/ce95287-capsense-csd-using-tuner-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95284-capsense-csd-design-psoc-3-and-psoc-5lp
http://www.cypress.com/documentation/application-notes/an72382-using-psoc-3-and-psoc-5lp-gpio-pins
http://www.cypress.com/documentation/application-notes/an60580-sio-tips-and-tricks-psoc-3-psoc-5lp
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文書番号 文書名 

KBA82883 Controlling a PSoC® 3 and PSoC 5LP GPIO in Firmware 

KBA91716 Differences Between SIO and GPIO Pins in PSoC® 3 and PSoC 5LP 

セグメント LCD 

AN52927 PSoC® 3 and PSoC 5LP - Segment LCD Direct Drive 

CE95368 Segment LCD with PSoC® 5 
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名前： Nidhin MS 

役職: 上級アプリケーション エンジニア 

経歴: Government   Engineering  College ( トリチュール、インド )  を卒業し、 電子通信工学の学士号を取得しました。 

技術的関心分野はアナログ信号処理、低消費電力設計、および静電容量タッチ センシングです。 

http://www.cypress.com/
http://www.cypress.com/knowledge-base-article/controlling-psoc-3-and-5lp-gpio-firmware-kba82883
http://www.cypress.com/knowledge-base-article/differences-between-sio-and-gpio-pins-psoc-3-and-psoc-5lp-kba91716
http://www.cypress.com/documentation/application-notes/an52927-psoc-3-and-psoc-5lp-segment-lcd-direct-drive
http://www.cypress.com/documentation/code-examples/ce95368-segment-lcd-psoc-5
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ったセキュリティ違反から生じる一切の責任を負わない。加えて, 本書面に記載された製品には, エラッタと呼ばれる設計上の欠陥またはエラーが含まれている可能性があ

り, 公表された仕様とは異なる動作をする場合がある。適用される法律により許される範囲内で, Cypress は, 別途通知することなく, 本書面を変更する権利を留保する。

Cypress は, 本書面に記載のある, いかなる製品若しくは回路の適用又は使用から生じる一切の責任を負わない。本書面で提供されたあらゆる情報 (あらゆるサンプルデザ

イン情報又はプログラムコードを含む) は, 参照目的のためのみに提供されたものである。この情報で構成するあらゆるアプリケーション及びその結果としてのあらゆる製

品の機能性及び安全性を適切に設計, プログラム, かつテストすることは, 本書面のユーザーの責任において行われるものとする。Cypress 製品は, 兵器, 兵器システム, 

原子力施設, 生命維持装置若しくは生命維持システム, 蘇生用の設備及び外科的移植を含むその他の医療機器若しくは医療システム, 汚染管理若しくは有害物質管理の運用

のために設計され若しくは意図されたシステムの重要な構成部分としての使用, 又は装置若しくはシステムの不具合が人身傷害, 死亡若しくは物的損害を生じさせるような

その他の使用 (以下「本目的外使用」という。) のためには設計, 意図又は承認されていない。重要な構成部分とは, それの不具合が装置若しくはシステムの不具合を生じ

させるか又はその安全性若しくは実効性に影響すると合理的に予想できるような装置若しくはシステムのあらゆる構成部分をいう。Cypress 製品のあらゆる本目的外使用か

ら生じ, 若しくは本目的外使用に関連するいかなる請求, 損害又はその他の責任についても, Cypress はその全部又は一部をとわず一切の責任を負わず, かつ Cypress はそ

れら一切から本書により免除される。Cypress は Cypress 製品の本目的外使用から生じ又は本目的外使用に関連するあらゆる請求, 費用, 損害及びその他の責任 (人身傷害

又は死亡に基づく請求を含む) から免責補償される。 

Cypress, Cypress のロゴ, Spansion, Spansion のロゴ及びこれらの組み合わせ, WICED, PSoC, CapSense, EZ-USB, F-RAM, 及び Traveo は, 米国及びその他の国に

おける Cypress の商標又は登録商標である。Cypress のより完全な商標のリストは, cypress.com を参照すること。その他の名称及びブランドは, それぞれの権利者の財産

として権利主張がなされている可能性がある。 
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